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I. Introduction
Visually, Arden: The World of William Shakespeare is an amalgam of historical accuracy
and stagecraft. It is meant to not only place players in a world based on realistic reproductions,
but to also lure them into a highly dramatic and colorful “dreamscape”. Every facet of the
game should have its own personality, right down to the very trees that make up the forests of
Arden. Each city will have its own flavor and design that will make it instantly recognizable to
the player even if he or she is not using a map. As of early 2007, this project is still an
academic‐oriented endeavor, which is fortunate in the sense that public expectations of the art
department will likely be low. Rather than fulfill these low expectations, the goal should be to
surpass them by a landslide. The goal should be to make the game look just as good as any
other commercially available MMORPG sitting on store shelves right now.
The purpose of this guide is to provide you, the art director, (or someone in a job of
similar capacity) a roadmap for producing artwork for Arden. The guide will cover technical
aspects of art creation as well as aesthetic recommendations. It is by no means the definitive,
end‐all resource for these subjects, and in fact, the writer encourages you to add to it or amend
sections in which you feel are not helpful. The first part of the guide will cover everything from
preparing meshes (3D models) to implementing them into Multiverse (our engine of choice). If
you have any questions regarding the content on the following pages, please contact the
original writer at rory.starks@gmail.com and he will be happy to assist.
As of this writing, the Multiverse platform is currently in beta stages at version 0.7. Not
all of the features have been fully implemented. For the latest information about the engine
please consult www.multiverse.net. It is possible that some of the technical data collected here
could also be incorrect after subsequent updates to the software. If this is the case, the writer
is truly sorry for any inconveniences this might cause. As stated previously, the website for
Multiverse is the place to go for the most recent information regarding features and tools of
the engine.
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II. Technical Background
A. Prerequisites
If you are reading this manual then it is safe to assume you have some working
knowledge of 3D game graphics, an art background, or a desire to produce artwork for Arden!
If one or more of these assumptions is true, then you are on the right track. It would be nice to
provide detailed information about 3D modeling and using programs like Photoshop for texture
creation, but that is not the focus of this manual. If you seek guidance in these areas there are
a few books listed below that can help.
3D modeling (game art specific)
‐Creating the Art of the Game by Matthew Omernick (New Riders Publishing, 2004)
‐The Game Artist’s Guide to Maya by Michael McKinley (Sybex, Inc., 2005)
‐Discover the Game with Alias by Katsunori Kondo (Alias Systems Corp., 2006)
2D artwork and texture creation
‐The Dark Side of Game Texturing by David Franson (Premier Press/Thomson, 2004)
‐3D Game Textures: Create Professional Game Art Using Photoshop by Luke Ahearn (Focal
Press, 2006)
In addition to skills relevant to any artist position for the Arden project, there are also
certain applications that you will need to use. There are obviously alternatives for many of
these packages, so if there is a program you are more familiar or comfortable with, by all means
go ahead and use that program. This guide makes many assumptions, and one of those is that
the reader is at least using Maya 8.0 and Photoshop CS2. With these programs you will find the
path of least resistance because the art production pipeline for Arden has been tailored for
their use. The software you will need is listed below.
Required software:
‐Autodesk Maya 8.0 or later (any version compatible with the COLLADA exporter should be fine)
‐Feeling Software’s ColladaMaya exporter (http://www.feelingsoftware.com/)
‐Adobe Creative Suite 2 or later (includes Photoshop and Illustrator)
‐Multiverse Tools (http://www.multiverse.net/developer/login.jsp)
‐Adobe Photoshop Normal Map and DDS Authoring Plug‐ins
(http://developer.nvidia.com/object/nv_texture_tools.html)
Optional software:
‐Terragen (http://www.planetside.co.uk/terragen/)
‐ConTEXT (http://www.context.cx/ ‐ useful for editing material and frameset files)
‐Corel Painter IX (not required but still a useful paint program)
‐DDS Thumbnail Viewer (http://developer.nvidia.com/object/nv_texture_tools.html)
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B. Multiverse software overview
The Multiverse tools include several pieces of software that will be helpful for an artist
working on Arden. One of the most important tools is the Model Viewer. Although it is very
feature‐limited and essentially just a browser for Multiverse‐compatible assets, it is quite useful
in determining how your meshes and textures will appear in the game world.

Fig. 2.01 – Model Viewer with an example mesh loaded

File Menu
From the File Menu (see Figure 2.01) models can be loaded (Load Model...) and asset
repository (Designate Asset Repository...) can be designated. Models loaded through the
viewer should be in the .mesh format. COLLADA and Ogre XML files are also compatible;
however, the material files will not be used so the model will show up with a solid white color.1
The “Designate Asset Repository...” option allows you to declare the directory in which
you would like to store your local assets for Arden. The asset repository is a group of
1

http://update.multiverse.net/wiki/index.php/Model_Viewer_0.7#Loading_models. Model Viewer – Loading
Models.

5

directories where you can store all of the media files for the game world. This includes 3D
meshes, textures, material scripts, fonts, interface graphics, and even audio files.2 The first
time the Multiverse tools are loaded an asset repository directory must be designated. This can
be any location on the local drive, though it should be in an easily accessible area. For example,
you could create a folder called ‘Media’ in the Multiverse Tools folder of the Program Files
directory and select it as your repository. This is also the location where one of the three
sample asset packages3 should be unzipped. It is recommended that the “Complete Asset
Repository” is used because it comes with many files that are helpful references. If you are
working specifically on art using your own (meaning not the server) computer, you will probably
want to make sure you do not use the world folder from the Multiverse client software as your
asset repository. The world directory is managed by the client and server software, so any
custom content placed in these folders could be inadvertently overwritten or deleted. After
setting up the location of your local media, you will never have to do this again.
View Menu
The view menu contains several options to view different elements of a mesh. The
Multiverse Developer Wiki gives descriptions of each of these options in Figure 2.02.
View Menu Description
Use the view menu to change the display and aspects of how the model is displayed. Choose:
•
•
•
•
•
•
•
•

Wire Frame ‐ display the model wire frame.
Display Terrain ‐ hide or show the ground terrain.
Spin Camera ‐ rotate the view angle continuously.
Spin Light ‐ rotate the light source continuously.
Show Bounding Box ‐ display the model bounding box.
Show Collision Volumes ‐ display collision volumes.
Display Bone Information ‐ display a dialog box with information on the bones (for animated models).
Set Maximum Frames Per Second ‐ display a dialog box that enables you to specify a maximum number
of frames per second for the Model Viewer. This is useful to limit Model Viewer's resource consumption.
Fig. 2.02 – View Menu

Main Program Tabs
The Model Viewer has four main tabs across the left side of the window: Sub Meshes,
Animations, Lighting, and Camera. Each of these tabs allows alteration in the way the model is
presented in the main window; however, permanent adjustments cannot be made. One of the
more useful sections is the Sub Meshes tab. On this panel you will find a list of the submeshes
contained within the loaded .mesh. Each submesh is named as indicated in the Outliner in
Maya. The checkbox next to each submesh can be used to toggle its visibility. You might find

2
3

http://update.multiverse.net/wiki/index.php/Setting_Up_an_Asset_Repository. Setting Up and Asset Repository.
http://update.multiverse.net/wiki/index.php/Download_an_Asset_Repository. Download an Asset Repository.
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this useful in cases where you want to see inside a building by hiding its walls or remove layers
of armor or clothing from a character model.4
Additional Multiverse Tools Useful for Artists
Once you have created a model and are ready to implement it into Arden, you will want
to gather its relevant files and bring them into the Asset Importer. This process will need to be
done on a computer connected to one of the Arden servers, so make sure you have access
before using this program. The purpose of the Asset importer is to create definition files and
incorporate media into the repository5 so it can be placed using the World Builder tool.
Another useful program is the Mosaic Creator. This program can take a 16‐bit grayscale
heightmap (PNG format) and convert it into a series of images and a mosaic description file
(MMF).6 This is very useful for breaking up high resolution heightmaps exported from terrain
software into more manageable chunks.
Multiverse also comes with a Terrain Generator, which can be useful for generating
terrain quickly, however, it might be easier to use one of the many commercial terrain‐
generating tools available on the web. L3DT Pro (http://www.bundysoft.com/L3DT/), PnP
Terrain Creator (http://www.pnp‐terraincreator.com/), Terragen
(http://www.planetside.co.uk/terragen/), and even Photoshop7 can be used to create
Multiverse Terrain. Any of the aforementioned tools will work for creating terrain, but you may
want to try out a few of them to find the one that best suits your needs.

4

http://update.multiverse.net/wiki/index.php/Model_Viewer_0.7#Editing_models. Editing Models.
http://update.multiverse.net/wiki/index.php/Using_Asset_Importer. Using Asset Importer.
6
http://update.multiverse.net/wiki/index.php/Using_Mosaic_Creator_%28version_0.7%29. Using Mosaic Creator.
7
http://www.blitzbasic.com/Community/posts.php?topic=42659. Creating Heightmaps with Photoshop.
5
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III. Technical Information
A. Model Specifications and Pre‐import Preparation
Before you get to the step of importing a model into Multiverse’s proprietary Ogre3D
format, there are a few attributes that you will want to adjust. Doing so will make the import
process a breeze and ensure that the mesh will appear correctly once it is placed into Arden.
The following sections detail everything you need to know about setting up your models for
Multiverse. It is important to note that this section of the manual does assume the reader is
working with Maya, so if you are using another 3D package, consult the Multiverse Developer
Wiki or the Developer Forums for the information about your particular program. That said,
the information contained here is applicable regardless of your platform, so if you are familiar
enough with the 3D software you use it should still apply.
Texture File Formats
Multiverse currently supports a wide variety of image formats including PNG, TGA
(Targa), BMP (Bitmap), JPEG, and DDS. Depending on the function, it will probably make sense
to use only a few of these; on the other hand, there is certainly the option to use all of them.
For the Arden project, DDS files will be used extensively for 3D assets with the occasional Targa
file used in situations where less compression is desirable. Targa files make the most sense
when implemented as interface graphics. 32‐bit Targa textures include an 8‐bit alpha channel
that is useful for windows like the chat box or ability bar where you might want the
environment to show through. Take a look at the interface graphics included with the
complete asset repository for some examples. PNG files are used for the terrain heightmaps
because of their immense palette size, which is particularly useful considering the subtlety
required for smooth, flowing terrain.
Taking the above information into consideration, Figure 3.01 details various file types
and their usage in games (specifically Arden).
File Type

Extension

Typical Usage8

DirectDraw Surface
(DXT1)

.dds

Most diffuse, specular, and normal maps will
use this format. More compressed than DXT3
and DXT5. Offers an optional 1‐bit alpha
channel. DDS can also store cubemaps and
mipmap levels.

Direct Draw Surface
(DXT3 and DXT5)

.dds

Same usage as DXT1. Both DXT3 and DXT5
include optional alpha channels – explicit or
interpolated, respectively.9

8
9

http://www.ogre3d.org/wiki/index.php/All_about_textures. A Brief Summary of Image File Formats – Ogre Wiki.
Ahearn, Luke. 3D Game Textures: Create Professional Game Art Using Photoshop. Focal Press, 2006.
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Targa

.tga

User interface graphics and some 3D textures.
Lossless file format with optional 8‐bit alpha.

Window Bitmap

.bmp

An alternative file type is recommended as
bitmaps tend to be very large. Bitmaps can
be used by games, but this format will not be
implemented in Arden.

PNG

.png

Useful for heightmaps and any high‐color
asset. Supports 16 million colors; lossless.

JPEG

.jpg

Although the JPEG format is useful for
instances where you need high‐compression,
use the DDS format instead.

Compuserve GIF

.gif

256 color limited palette; unsupported by
Multiverse.
Fig. 3.01 – Graphics File Types

Texture Resolution
The textures used in Arden should not exceed 1024 x 1024. Average textures should be
around 512 x 512 in size with 1024 x 1024 images being used for objects of the higher detail. If
you are unsure of what resolution you should use, imagine that 128 pixels equals one meter
and scale your textures accordingly. There are certainly instances where this rule will not apply,
but it can be a good basis for general architectural or organic textures.
From an aesthetic standpoint the areas of highest detail should take up more space on
the texture. As an exercise, take a look at character model in your favorite MMORPG and
notice how different areas of the mesh have varying levels of detail (in resolution, at least). A
plain, white tunic, for instance, will need far less texture real estate than an engraved chest
plate. Of course, technical limits of modern computers aside, there is no right or wrong answer
when it comes to determining how much space a particular texture element should be given.
The textures should strike a balance within their associated meshes in addition to other meshes
in the game. The same information above can be applied to effects textures as well. Normal
maps and specular maps do not necessarily need to be the same resolution as the diffuse
(color) texture, but the same concerns should be addressed.
Maya Setup
Multiverse requires models to be imported in a Y‐up orientation. This setting can be
adjusted under the “Settings” portion of the preferences menu in Maya. The units should be
set to centimeters. A useful grid setting (Display > Grid > Option Box) is shown in Figure 3.02.
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Length and width: 3000.0000 units
Grid lines every: 100.0000 units
Subdivisions 1
Fig. 3.02 – Grid Settings.

Because of the large grid size, the camera clipping planes must also be increased. Go to View >
Select Camera and in the attribute editor change the Near Clip Plane to 0.100 and the Far Clip
Plane to 100000.000. Source files should always be saved in Maya ASCII (.ma) and for
animations the frame rate should be set to NTSC (30fps).10
Mesh Guidelines
The Multiverse documentation covers some general guidelines with regard to polygon
count (triangles) in static mesh creation. They suggest 3000 triangles per character, 1500‐2000
for mobs, 1500 for buildings, and 200 for assorted objects (like weapons and tools).11 As
mentioned in the source, the numbers given are by no means a limit, so use your best
judgment. Larger objects with areas of greater geometric detail will undoubtedly have higher
polygon counts. After completing a model, examine it and look for places where extraneous
geometry could be replaced with textures that give the illusion of depth.
Just as higher resolution textures should be used where higher detail is important, more
polygons can be used in areas that warrant their use. For example, character models can have
roughly as many triangles in their heads as they do in the rest of their entire body. This might
seem unusual, but consider that details like folds in clothing, joints in armor, and seams are
going to be easier to convey through the use of textures than they are through geometry. With
that in mind you can use more polygonal detail in faces to create more lifelike characters.
UV Layout
When laying out your UVs, take advantage of as much of the available space as you can.
If this means tiling something horizontally or vertically (or both), then do so (within reason, of
course). A common UV method is to first unwrap the object and then scale/rotate/translate
the pieces so that a checkerboard texture appears undistorted on the model. This can be done
in Maya easily by applying a new Lambert texture and then creating a checker render node (as
shown in Figure 3.03).

10
11

http://update.multiverse.net/wiki/index.php/Creating_Assets#Maya. Maya Guidelines.
http://update.multiverse.net/wiki/index.php/Creating_Assets. Creating Assets.
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Fig. 3.03 – UV Layout with checkerboard texture on model.

Submeshes
Models created for Arden can contain multiple submeshes. This is a handy way to break
up a mesh into several parts if you plan to reuse surface textures or if there are accessory
objects that do not always need to be present. In general, you will use submeshes on any
model where you have multiple textures. Be reasonable in the amount of submeshes that you
use – each one increases the number of calls to the graphics card.
Animated Meshes
There are a few guidelines that must be followed when animating meshes for
Multiverse. First of all, there are two types of files that need to be created in order for the
animations to work. The composite mesh file is the base figure and any related accessories
(clothing, armor, etc.). Think of this file as the static mesh version of the animated model. It
will be referenced in the material and physics files but it will also include skin weight and the
positions of the bones. The second type of file is the animation file. The animation file is like a
script for the composite mesh. The skin and skeletal animation data is applied to the composite
mesh and determines how the model will look throughout its various cycles.12
When rigging character models, be aware that there is a 64 bone count limit in
Multiverse. The original female model that has been designed for Arden has somewhere
around 20‐25 bones, so it is unlikely that you will even approach the limit. In order for the
12

http://update.multiverse.net/wiki/index.php/Creating_Assets#Animation_guidelines. Animation Guidelines.
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model to export properly you will also need to include all active bones and the root node when
you skin the model.13
Unlike the character models that ship with Multiverse, Arden’s character models will
contain very few submeshes. Instead of attaching several submeshes to the same model,
different and layered textures for the customizable elements of the character will be used. This
does not include “attached” items like tools and weapons.
Animation List (bipedal NPCs and PCs)
The animations on the following list (Figure 3.04) are the bare minimum required for
Arden’s character models. Additional animations could also be created, though special
circumstances must justify their use. Most cycles need not be more than a second in length.
Depending on the gameplay and/or typical duration of the specified action, it is quite possible
that many of the animations will not need to take up an entire second (30 frames). Cyclical
animations like idle, combat idle, running and walking can be longer than 30 frames and must
start and end on the same position to animate smoothly.

Type

Description

Idle
(cyclical)

Base animation for a character standing in a relaxed position. Keep
movement to a minimum and the duration relatively short. Simple
animations include breathing and slightly turning the head back and forth –
panning the horizon.

Combat Idle
(cyclical)

Triggered when the character is engaged in combat. Character holds its
hands slightly above the waist with elbows bent in sort of a loose boxers’
stance (though not as jumpy). Feet are slightly apart and flat on the ground.
Consider that this idle stance will be used with a wide variety of weapons –
both offensive and defensive. All attack‐related animations will branch
from combat idle.

Run
(cyclical)

Fast‐walk or stride animation. Particular attention should be paid to female
characters wearing dresses because of the way they will deform in sharp,
fast movements.

Walk
(cyclical)

Mainly used by NPCs so they can move places without running like the
player characters.

Jump

Reasonably high jump cycle with the character’s knees bent and arms
outstretched.

13

http://update.multiverse.net/wiki/index.php/Platform_Tutorial_Importing_Animated_Models. Importing
Animated Models.
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Recoil

Reactive animation when a character is hit by an attack. Must begin and
end with the combat idle stance.

Attack

One‐handed attack from left to right with the right hand. Must begin and
end with the combat idle stance.

Death

Basic death animation lasting around a second or less. Begins with combat
idle stance and ends with character face down on the ground. Keep in mind
that weapons are still held during death animation.

Harvest

Played when a character is harvesting resources. This could be a single,
simple animation or several job‐specific animations. Current job list
includes striking a rock with an axe, hitting a tree with an axe, using a scythe
to cut grass, pulling up roots, and collecting berries from bushes. All begin
and end from the idle stance. Each animation should last for the duration of
the harvest action.

Craft

Played when a character is crafting an item. As with the harvesting
animations, these could be simplified into one animation or spread out
across several different animations.
Fig. 3.04 – Animation List.

Naming Conventions
Naming conventions are very important when dealing with potentially thousands of in‐
game assets in an MMORPG such as Arden. Using a system devised by David Green (DG
Unreal)14 Arden’s assets can be managed in a well‐defined manner.
Static Mesh Examples
asm_type_subtype
asm_type_subtype_description
asm_type_subtype##
asm_type_subtype##_description
Animated Mesh Examples
aam_type_subtype
aam_type_subtype_animationDescription
aam_type_subtype##_animationDescription_duration
Texture Examples
14

http://www.lilchips.com/dgunreal/. DG Unreal website.
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ast_type_subtype##_shaderType
ast_type_subtype##_frame_## (for animated textures)
asm stands for Arden Static Mesh
aam stands for Arden Static Mesh
ast stands for Arden Static Texture
The type and subtype names should be used to classify where the object goes. This is
helpful when cycling through alphabetized lists of files because things can be found very
quickly. Here are some examples using actual file names from Arden.
asm_bldg_theatre.mesh
asm_bldg_tavern01.mesh
ast_bldg_monastery01_windows_normal.dds
ast_resource_root01_leaves_diffuse.dds
As you can see, we have arden static mesh first and then bldg (for building) finally
followed by the subtype, which is "theatre," and that is typically where you will say what the
object actually is. You can use a description or number following the subtype if you need to
further clarify the purpose or type of a mesh.
The naming convention extends into submeshes as well. The file
asm_bldg_B_house02 has six submeshes each with descriptive suffixes. The roof submesh,
for instance, is named asm_bldg_B_house02_roof in the outliner. It is absolutely vital that
you name the submeshes in the outliner due to the fact that the collision system references
these names directly. Shading groups must also be labeled using a derivative of the naming
convention, but this will be covered in another section.
Collision Boxes
Collision boxes should be included with any mesh brought into Arden that physically
interacts with players or other objects. Collision volumes are defined within the 3D software
and then exported through the conversion process into a .physics file. This file is later included
during the Asset Importer stage. You will probably want to finish an entire mesh first before
defining collision so you will know where everything is located.
There are four types of collision available in Multiverse and they are shown below in a
table (Figure 3.05) provided by the developer wiki:
Collision Volume Shape

Description

Name Prefix

Oriented Bounding Box

Rectangular cuboid with any orientation. That is,
a box with six rectangular faces defined by three
orthogonal axes, represented by unit vectors, a
center, and three "extent" values, one for each
axis. The resultant box has dimensions 2 *

mvcv_obb_
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extent1 by 2 * extent2 by 2 * extent3.
Axis Aligned Bounding Box Rectangular cuboid whose edges are aligned with mvcv_aabb_
(parallel to) the world axes (X, Y, and Z). Since
the axes are always the same, they are omitted,
so all you need to specify an AABB are two points
in space: the x, y, and z coordinates of the
minimum point, and the x, y, and z coordinates
of the maximum point.
Sphere

Simple sphere defined by a center point and a
radius.

mvcv_sphere_

Capsule

Cylinder with any orientation capped with a half
sphere on both ends.

mvcv_capsule_

Fig. 3.05 – Collision types and prefixes.

In order to create collision, make sure that you have first given all of your submeshes
coherent names in Maya’s outliner. Also, merge any submeshes that share the same texture.
Now you are ready to generate collision.
Begin by creating a cube primitive and open up the outliner. Select the cube in object
mode and change its name like in the following example:
mvcv_obb_asm_type_subtype
We’re not quite done yet. Maya has some special rules regarding the naming of collision
volumes, but once you have set one up you can duplicate it to reuse it.
mvcv_obb_asm_type_subtypeshape
Finally, you will want to add _01 to the end of the collision box name because Maya will
automatically count up if you duplicate the primitive. For our example, the final name would
be:
mvcv_obb_asm_type_sybtypeshape_01
When this object is duplicated (Windows: Ctrl‐D or OS X: Apple‐D) the next one will be _02.
Use the translate, rotate, and move tools to align the primitive to a solid surface of the
target object. For example, enlarge the box to fill the space of a wall or column. An example is
shown in Figure 3.06.
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Fig. 3.06 – Collision volume surrounding a table mesh.

Collision is not an exact science, so you will probably need to adjust the primitives and
experiment with them in the game world a few times to get the hang of it. One useful trick is to
place the initial collision cube into a layer (accessible from the Channel Box/Layer Editor) and
give the layer a bright highlight color. When viewing in wireframe mode (Shading > Wireframe)
the bright edge color will help you see how the collision is actually lining up with your model.
Putting collision into a layer also allows you to hide it so that you can still make adjustments to
the base model. If necessary, you can also adjust the transparency of the default Lambert
shader in order to see through the collision more clearly.
Shading Groups
Prior to exporting, change the name of the shading group by navigating to its output
in the texture’s attribute editor panel). The shading group doesn’t
connection (click on
necessarily need to have the entire hierarchy of the model name, just something uniform and
easy to remember. The table from asm_obj_furniture_01 _table has a shading group
named furniture_01_tableSG. This name will be used in the material files created later.
Final Cleanup
Before proceeding to the next step delete the history (Edit > Delete All by Type >
History) and freeze the transforms (Modify > Freeze Transformations > Option Box) on the base
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model. In addition, freeze the translate and scale transforms on the collision volumes. You
must also freeze transforms prior to building a skeleton. Multiverse suggests running the
Cleanup tool (Mesh>Cleanup...) before exporting or rigging a model.15

15

http://update.multiverse.net/wiki/index.php/Creating_Assets#Maya. Guidelines for Specific Modeling Tools, 3.2
Maya.
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B. Exporting to COLLADA
Multiverse requires that all imported files start in COLLADA, which is a new cross‐
platform supported 3D format. The Khronos Group gives this description:
COLLADA™ defines an XML‐based schema to make it easy to transport
3D assets between applications ‐ enabling diverse DCC and 3D
processing tools be combined into a production pipeline. The
interchange format provides comprehensive encoding of visual scenes
Including shaders and physics, and even multiple versions of the same
asset. COLLADA FX enables shaders to be authored and packaged using
OpenGL Shading Language so that leading 3D authoring tools can work
effectively together to create OpenGL / OpenGL ES applications and
assets.16

Installing the COLLADA Plug‐in
Before importing into Multiverse, you must first export your model from Maya (or
equivalent program) to the COLLADA format. There is a plug‐in available for Maya and 3DSMax
at Feeling Software’s website (http://www.feelingsoftware.com/content/view/16/30/lang,en/).
Simply download and install the plug‐in, then enable it in Maya through Window >
Settings/Preferences > Plug‐in Manager. If you are unable to load the COLLADA exporter, try
placing Glut32.dll17 into your Windows/System32 directory and restart Maya.
Export Dialog
When your model is completely prepared, you are now ready to convert to COLLADA. In
object mode, select the entire mesh and go to File > Export All... > Option Box. You will then
see the window shown in Figure 3.07. Examine the settings in the image and make sure that
yours are the same. The plug‐in will automatically triangulate your model if you want it to do
so. This is fine to use but be aware that the triangulation, particularly on organic objects, might
not end up the way you want it. If this happens you’ll want to go back and use the Split Polygon
Tool in Maya to triangulate by hand.

16
17

http://www.khronos.org/collada/. COLLADA – Digital Asset Exchange Schema for Interactive 3D.
http://www.xmission.com/~nate/glut/glut‐3.7.6‐bin.zip. Glut32.dll download link.
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Fig. 3.07 – COLLADA Exporter Dialog.18

After clicking “Export All” you will be asked to save the .dae file. It is helpful if you save this file
in the Multiverse Model Viewer directory because it will save you some time with the next step
using the conversion tool.

18

http://update.multiverse.net/wiki/index.php/Exporting_Models#Exporting_from_Maya.
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C. Importing into Multiverse
ConversionTool.exe
ConversionTool.exe – run from the command prompt – will be used to convert the
COLLADA .dae files into Multiverse’s proprietary Ogre3D file format. After running, the
program will output .mesh, .material, .physics, and .skeleton files. The physics and skeleton
files are only created if you have collision and/or bone data in the files, respectively. In most
instances when a static mesh is converted, the following command will be sufficient:
ConversionTool asm_type_subtype.dae

Animated models require some additional flags in order to work properly. After running the
ConversionTool program on the composite mesh, it will need to be run again to add the
animations to the skeleton file. Use the following command in order to do this:
ConversionTool --base_skeleton aam_type_subtype.skeleton
--animation anim1 animationDescription.dae
--animation anim2 animationDescription.dae
--out_skeleton aam_type_subtype_animation.skeleton

This command, of course, will be typed on a single line. The skeleton file that is created by this
process (aam_type_subtype_animation.skeleton) can now be imported or viewed in the
Model Viewer.
Material Files
Although the Conversion Tool does generate a .material file, it is likely that this file will
need to be edited before the texture will appear in either the Model Viewer or in Multiverse
itself. Editing material files not only ensure the textures appear as they are intended, but it also
allows for the addition of effects textures like normal and specular maps. Material files must
also be amended in order for alpha channel information to be displayed correctly. In Figure
3.08 you will find an example of a material file currently being used in Arden.
material asm_bldg_house_locked.house_lockedSG
{
technique
{
pass
{
shading phong
ambient
diffuse
specular
emissive

1.00000
1.00000
0.00000
0.00000

1.00000
1.00000
0.00000
0.00000

1.00000
1.00000
0.00000
0.00000

1.00000
1.00000
1.00000 0.00000
1.00000
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texture_unit
{
texture ast_bldg_house_locked_diffuse.dds
tex_coord_set 0
}
}
}
}
Fig. 3.08 – House Material File.

As you can see, the header of the file contains the universal name for the mesh followed by the
shading group name (house_lockedSG) specified in Maya. At this point in time,
ConversionTool.exe does not correctly extract the shading group data from the dae file so it
needs to be edited manually. Another area of interest is the texture_unit portion of the
script. It is in this area where diffuse (color) textures can be added. Make sure the filename is
correctly entered because this is where the image file is referenced.
If an alpha channel is being used some additional data needs to be added to the script.
Figure 3.09 has the additional lines highlighted.
material asm_resource_root01.root01_leavesSG
{
technique
{
pass
{
shading phong
ambient
diffuse
specular
emissive

1.00000
1.00000
0.00000
0.00000

1.00000
1.00000
0.00000
0.00000

1.00000
1.00000
0.00000
0.00000

1.00000
1.00000
1.00000 0.00000
1.00000

cull_hardware none
cull_software none
texture_unit
{
alpha_rejection greater 128
texture ast_resource_root01_leaves_diffuse.dds
tex_coord_set 0
}
}
}
}
Fig. 3.09 – Root Material File.
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The most important addition is the alpha_rejection greater 128 line in the
texture_unit section. The “cull” lines are only needed in meshes where alpha textures are
viewed from both sides. Without these lines the texture will only be shown facing the direction
of the normals. An alternative to using the cull scripts would be to duplicate the faces with the
alpha transparencies, then translate their position to avoid any z‐fighting, and finally reverse
the normals.
The last example script (Figure 3.09) will show how normal and specular maps can be
implemented into a material file.
material asm_bldg_monastery01.monastery01_windowsSG
{
technique
{
pass
{
// Vertex program reference
vertex_program_ref Examples/CompoundVS
{
param_named_auto FogSettings fog_params
param_named_auto WorldViewProj worldviewproj_matrix
param_named_auto WorldMatrix world_matrix
param_named_auto LightPosition[0] light_position_object_space 0
param_named_auto LightPosition[1] light_position_object_space 1
param_named_auto LightAttenuation[0] light_attenuation 0
param_named_auto LightAttenuation[1] light_attenuation 1
param_named_auto EyePosition camera_position_object_space
}
// Fragment program reference
fragment_program_ref Examples/CompoundPS_20_NS
{
param_named LMe float4 0 0 0 1
param_named_auto LMa ambient_light_colour
param_named_auto LMd[0] light_diffuse_colour 0
param_named_auto LMd[1] light_diffuse_colour 1
param_named_auto LMs[0] light_specular_colour 0
param_named_auto LMs[1] light_specular_colour 1
param_named shininess float 20
}
// Normal map
texture_unit
{
texture ast_bldg_monastery01_windows_normal.tga
}
// Specular map
texture_unit
{
texture ast_bldg_monastery01_windows_specular.dds
}
// Diffuse map
texture_unit
{
texture ast_bldg_monastery01_windows_diffuse.dds
}
}
}
}

Fig. 3.10 – Monastery Window Material Script.
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Note the three texture files listed at the bottom of the script: _normal, _specular, and _diffuse.
These three must be in this order to be processed correctly by the graphics card. Use the
comments above each texture for reference.
For animated meshes, like character models, the vertex program reference needs an
alternative script which uses the CompoundVS_Skinned shader19 instead of the CompoundVS
shader model. This script is shown in Figure 3.11.
// Vertex program reference
vertex_program_ref Examples/CompoundVS_Skinned
{
param_named_auto FogSettings fog_params
param_named_auto WorldMatrix3x4Array[0] world_matrix_array_3x4
param_named_auto ViewProj viewproj_matrix
param_named_auto WorldMatrix world_matrix
param_named_auto LightPosition[0] light_position_object_space 0
param_named_auto LightPosition[1] light_position_object_space 1
param_named_auto LightAttenuation[0] light_attenuation 0
param_named_auto LightAttenuation[1] light_attenuation 1
param_named_auto EyePosition camera_position_object_space
}

Fig. 3.11 – CompoundVS_Skinned Shader Model.

Viewing the Mesh in Model Viewer
By placing the mesh, physics, material, texture, and skeleton files in their respective
folders in the local asset repository, the .mesh file can be loaded into the Model Viewer for
examination. Once the model is loaded, check for any flipped normals or missing texture files.
If there is a texture missing then the mesh will either show up gray or white. If this happens,
check the Material box at the bottom left of the window to be sure that the text is not red. If it
is, there is more than likely a mismatch between the Shading Group and the material name in
the .material file. Another possibility is that the texture file is typed incorrectly in the material
file or that the texture is missing from the repository entirely.
Using the Asset Importer
When 3D assets for use in Arden, first create a material definition using the ast_ prefix
and attach the required files. Save the file and then create a mesh definition and attach the
required files to it. Creating the definition files will allow the items to be placed in the World
Builder.

19

http://update.multiverse.net/wiki/index.php/Platform_Tutorial_Editing_Material_Files. Editing Material Files.
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D. 2D Artwork – Interface Graphics
Layout Information and Recommendations
Interface graphics can be organized into image files in many ways. The best solution is
to tile graphics when possible and reuse portions rather than duplicating similar visuals across
several files. This is particularly true when working with heads‐up display (HUD) graphics like
windows and bars. These types of elements tend to have repeated areas or have the ability to
expand based on in‐game items and user preferences. For instance, a player might upgrade his
or her backpack to allow more items to be carried. With this in mind, it is beneficial to create
interface graphics which tile in multiple directions. Figure 3.12 illustrates this principle.

Fig. 3.12 – Tiling Example.

Using this method will allow the programmer to script windows of varying sizes rather than
having to design and implement each individual window in the game.
Icons are another interface element common to Arden. Instead of making literally
hundreds of individual files, icon graphics are managed in “sheets”. 256 icons at 64x64 pixels
can be stored in one 1024x1024 targa file. This is probably the most efficient method for
storing a large number of icons because breaking the set into smaller groups will cause more
calls to the video card and thus affect performance on the client side.
XML Imagesets
Imagesets are XML documents used to label the graphics found in the interface files so
they can be called in interface Python scripts. They are fairly simple to create and considering
the image files themselves contain no explicit information about what goes where, it is best if
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the artist creates his or her own imageset files. A small example is shown in Figure 3.13 with
the connected image file in Figure 3.14.
<?xml version="1.0" ?>
<Imageset Name="Icons" Imagefile="Icons.tga" NativeHorzRes="512" NativeVertRes="256"
AutoScaled="false">
<Image Name="INV_misc_parchment" XPos="0" YPos="0" Width="64" Height="64" />
<Image Name="INV_misc_skull" XPos="64" YPos="0" Width="64" Height="64" />
<Image Name="INV_misc_quills" XPos="128" YPos="0" Width="64" Height="64" />
<Image Name="INV_trade_sap" XPos="192" YPos="0" Width="64" Height="64" />
<Image Name="INV_trade_water" XPos="256" YPos="0" Width="64" Height="64" />
<Image Name="INV_trade_maple-syrup" XPos="320" YPos="0" Width="64" Height="64" />
<Image Name="INV_misc_shakespeare-text" XPos="384" YPos="0" Width="64" Height="64" />
<Image Name="INV_food_gruel" XPos="448" YPos="0" Width="64" Height="64" />
<Image Name="INV_food_bread" XPos="0" YPos="64" Width="64" Height="64" />
<Image Name="INV_food_milk" XPos="64" YPos="64" Width="64" Height="64" />
<Image Name="INV_ability_attack" XPos="128" YPos="64" Width="64" Height="64" />
<Image Name="INV_ability_harvest-water" XPos="192" YPos="64" Width="64" Height="64" />
<Image Name="INV_ability_harvest-sap" XPos="256" YPos="64" Width="64" Height="64" />
<Image Name="INV_weapon_bow-fortune" XPos="320" YPos="64" Width="64" Height="64" />
<Image Name="INV_weapon_bow-sling" XPos="384" YPos="64" Width="64" Height="64" />
<Image Name="INV_weapon_bow-arrows" XPos="448" YPos="64" Width="64" Height="64" />
<Image Name="INV_weapon_club" XPos="0" YPos="128" Width="64" Height="64" />
<Image Name="INV_empty" XPos="64" YPos="128" Width="64" Height="64" />
<Image Name="INV_empty" XPos="128" YPos="128" Width="64" Height="64" />
<Image Name="INV_empty" XPos="192" YPos="128" Width="64" Height="64" />
<Image Name="INV_empty" XPos="256" YPos="128" Width="64" Height="64" />
<Image Name="INV_empty" XPos="320" YPos="128" Width="64" Height="64" />
<Image Name="INV_empty" XPos="384" YPos="128" Width="64" Height="64" />
<Image Name="INV_empty" XPos="448" YPos="128" Width="64" Height="64" />
<Image Name="INV_empty" XPos="0" YPos="192" Width="64" Height="64" />
<Image Name="INV_empty" XPos="64" YPos="192" Width="64" Height="64" />
<Image Name="INV_empty" XPos="128" YPos="192" Width="64" Height="64" />
<Image Name="INV_empty" XPos="192" YPos="192" Width="64" Height="64" />
<Image Name="INV_empty" XPos="256" YPos="192" Width="64" Height="64" />
<Image Name="INV_empty" XPos="320" YPos="192" Width="64" Height="64" />
<Image Name="INV_empty" XPos="384" YPos="192" Width="64" Height="64" />
<Image Name="INV_empty" XPos="448" YPos="192" Width="64" Height="64" />
</Imageset>

Fig. 3.13 – Demo Icons Imageset XML File.

Fig. 3.14 – Demo Icons Interface TGA File.
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IV. Style Guide
A. Architecture Concepts
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B. Character Concepts

Female Character Concept and Paperdolls by Sam Jerome.

Male Character Concept and Paperdolls by Sam Jerome.

